Lesson 3

Work with Lists
Copyright

Copyright 2018 Intuit, Inc. Intuit, Inc.
All rights reserved. 5601 Headquarters Drive
Plano, TX 75024

Trademarks

©2018 Intuit, Inc. All rights reserved. Intuit, the Intuit logo, Intuit ProLine, Lacerte,
ProAdvisor, ProSeries and QuickBooks, among others, are trademarks or registered
trademarks of Intuit, Inc. in the United States and other countries. Other parties’ marks
are the property of their respective owners.

Notice to Readers

The publications distributed by Intuit, Inc. are intended to assist accounting
professionals in their practices by providing current and accurate information.
However, no assurance is given that the information is comprehensive in its coverage
or that it is suitable in dealing with a client’s particular situation. Accordingly, the
information provided should not be relied upon as a substitute for independent
research. Intuit, Inc. does not render any accounting, legal or other professional
advice, nor does it have any responsibility for updating or revising any information
presented herein. Intuit, Inc. cannot warrant that the material contained herein will
continue to be accurate nor that it is completely free of errors when published.
Readers should verify statements before relying on them.
# Table of Contents

About the Author .................................................................................................................. 5
Lesson Objectives .................................................................................................................. 6
Use QuickBooks Desktop Lists ............................................................................................. 7
Edit the Chart of Accounts .................................................................................................... 8
Edit an Account ..................................................................................................................... 9
Add a Subaccount .................................................................................................................. 10
Customer, Vendor and Employee Centers ........................................................................... 12
Custom Contact Fields ......................................................................................................... 13
Work with the Customer Center and the Customers & Jobs List ........................................ 14
  Add Customers .................................................................................................................... 14
  Provide Additional Customer Information ........................................................................... 16
Sales Tax Settings .................................................................................................................. 17
Transactions from the Customers & Jobs List ...................................................................... 19
Work with the Employee Center ............................................................................................ 20
Work with the Vendor Center ................................................................................................ 21
  Add Vendors ......................................................................................................................... 21
Transactions from the Vendor List ......................................................................................... 23
Add Custom Fields ................................................................................................................ 24
Manage Lists .......................................................................................................................... 28
  Rename a list item ................................................................................................................. 34
Print a List .............................................................................................................................. 36
Add or Edit Multiple Items at One Time .............................................................................. 38
Lesson 3 – Work with Lists

Work with the Lead Center ................................................................. 40
Things to Note about the Lead Center .............................................. 42

Work with Lists – Review Questions .............................................. 43

Review Activities ............................................................................... 45

Answers to Review Questions ......................................................... 47
About the Author

Esther Friedberg Karp, MBA
President, EFK CompuBooks Inc.

Esther Friedberg Karp is an internationally-renowned trainer, writer, business consultant and speaker who was named one of the Top 10 QuickBooks ProAdvisors in the world, with the title Top International ProAdvisor.

Based in Toronto, Canada, Esther has the unique distinction of holding ProAdvisor certifications in the United States, Canada and the United Kingdom. She has authored materials and delivered educational and certification courses for Intuit in all those countries, as well as Australia where she conducted live QuickBooks Online training. She has spoken at Scaling New Heights, QuickBooks Connect and other conferences, as well as those of various accounting and professional organizations and written countless articles for Intuit Global.

Esther counts among her clients’ companies from around the world, as well as accounting professionals who seek her out on behalf of their own clients for her expertise in various countries’ editions of QuickBooks Desktop and Online, and for her talent in customizing QuickBooks usage for different industries.

Esther holds a BSc from the University of Toronto in Actuarial Science and Mathematics, and an MBA in Marketing and Finance from York University’s Schulich School of Business.

She can be reached at esther@e-compubooks.com or 416-410-0750.
Lesson Objectives

- Edit the company Chart of Accounts
- Add a new customer to the Customers & Jobs list
- Add a new vendor to the Vendor list
- Learn about custom fields and practice adding custom fields
- See how to manage lists in QuickBooks
Use QuickBooks Desktop Lists

QuickBooks Desktop lists organize a wide variety of information including data on customers, vendors, inventory items and more. Lists save time by helping you enter information consistently and correctly, such as:

- Names, addresses and other information about customers
- Contact information for vendors
- Descriptions and prices for products and services

NOTES
Edit the Chart of Accounts

The Chart of Accounts is your most important list because it shows how much your business has, how much it owes, how much money is coming in and how much is being spent. It is the backbone of any accounting system.

Step-by-Step: Display the Chart of Accounts

1. From the Lists menu, choose **Chart of Accounts** or press **CTRL+a**.

2. Scroll through the list.

The Chart of Accounts’ default display is by account type: balance sheet accounts first, followed by income and expense accounts. You can click on the column headings to sort by name or balance instead of by type.

**Notes**
Edit an Account

Step-by-Step: Edit an Account

1. In the Chart of Accounts, find the account you want to edit, then click on it (once – not a double-click) to highlight the row.

2. Right-click on the row then click Edit Account, or click the Account menu button then select Edit Account.

3. Edit the information accordingly.

4. Click Save & Close.

IMPORTANT: Some information, like Account Type, is not easily changed. If you set up an account in error and want to modify it but QuickBooks won’t let you make the change, you can delete the account and start over, assuming no transactions have been posted to it.

NOTES
Add a Subaccount

A subaccount is a way to break an account down into subcategories for reporting purposes. Subaccounts appear on reports as indented lines under the main or parent account. This hierarchy enables you to expand reports to show all subaccounts under a parent, or to collapse all subaccounts into a parent account for a one-line view.

**Step-by-Step: Add a Subaccount**

1. In the Chart of Accounts, click the **Account** menu button then choose **New**.
2. Select the appropriate account type (this must be the same account type as the parent account).
3. Click **Continue**.
4. Assign an appropriate account name and number if applicable.
5. Select the **Subaccount of** checkbox then select the parent account from the drop-down list.
6. Click **Save & Close**.
QuickBooks displays the new subaccount in the Chart of Accounts list.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>60100</strong> · Automobile</td>
<td>Expense</td>
</tr>
<tr>
<td><strong>60110</strong> · Fuel</td>
<td>Expense</td>
</tr>
<tr>
<td><strong>60120</strong> · Insurance</td>
<td>Expense</td>
</tr>
</tbody>
</table>

7. Close the Chart of Accounts by clicking the **x** in the top right of the Chart of Accounts window (not the x in the top right of the QuickBooks window as this will close the program!) or hit the **Esc** key.

**NOTES**
Customer, Vendor and Employee Centers

The Customer, Vendor and Employee Centers consolidate and organize important information. The centers contain names, addresses and other information about the items on these lists. They also hold more specific information, Contacts, Notes, To Do’s, Sent Email, custom fields and other details you may want to track for each customer, vendor or employee.
Custom Contact Fields

Each name listed on the Customer, Vendor and Employee Centers includes eight fields for contact information. All eight of these contact fields for phone numbers, email addresses and URLs can be customized per the drop-down list of available contact descriptions (mobile phones, social media information, etc.).
Work with the Customer Center and the Customers & Jobs List

The Customer Center’s Customers & Jobs list stores names, addresses and other information about your customers. It also holds information about the jobs or projects you may want to track for each customer.

The Customer Center is the dashboard that can launch sales forms (sales orders, estimates, invoices, sales receipts, statement charges, receive payments and credit memos/refunds) and display accounts receivable.

ADD CUSTOMERS

Step-by-Step: Add a Customer

1. There are multiple ways to do almost anything in QuickBooks. To access the Customer Center, you have four options:
   - Click Customers from the left-hand or top icon bar (depending on your View settings)
   - Choose Customer Center from the Customers drop-down in the menu bar
   - From the Home page, click the blue Customers tab in the Customers section
   - Press CTRL+j

2. Click the New Customer & Job menu button then choose New Customer.

3. In the Customer Name field, enter the name of the customer as you’d like it to appear on your Customers & Jobs list.

4. Press Tab past the Opening Balance field to leave this field blank.

   The Opening Balance field tells you how much each customer owes you on your start date, so when you enter the rest of your transactions from the day after your start date to today, all balances since your start date will be accurate.

   It is recommended to enter individual outstanding invoices one by one whenever possible rather than enter the outstanding balance owed in the Opening Balance field.

5. Complete the customer contact information appropriately.
You can have and use more than one Ship To address per customer or job. Add them with the Ship To drop-down or by clicking the + sign in the bottom right corner.
6. Click **OK** to add this customer. The Customer Center appears with the Customers & Jobs list along the left side. (New names appear at the top of the list. Right-click on the list then choose **Re-sort List** to return the names to alphabetical order.)

**IMPORTANT:** The Customers & Jobs list is the same as the Customer/Job list. It is called Customers & Jobs on the Customer Center and Customer:Job on forms. It is sometimes also referred to as simply the Customer list.

**PROVIDE ADDITIONAL CUSTOMER INFORMATION**

There are additional tabs for Payment Settings, Sales Tax Settings, Additional Info and Job Info where you can provide other important information.

**NOTES**
Sales Tax Settings

There are multiple levels of taxability in QuickBooks. Taxability can be assigned by the item, the customer and each individual sale for:

- **Item default taxability** - This determines whether the item is displayed as taxable or nontaxable each time it is used on a sales form. This is a default setting that can be overridden on the individual form when the item is used.

- **Customer default taxability**
  - **Tax Code** - Here you can set a customer to be taxable or nontaxable. If the customer is set up as nontaxable, this overrides the item setup when taxable items are used on a sales form. This can be changed on a sales form.
  - **Tax Item** - This is the line tax item to which the customer’s sales will default on the Sales Tax Report. If the customer’s tax code is Tax, the rate from the Tax Item drop-down will be assigned. If the customer’s tax code is Non, the rate will not be applied but the sale will still be grouped with that rate in the Sales Tax Report. This can also be changed on a sales form.
The Payment Settings tab is where you enter customer account numbers and credit limits. You can also record information about each customer’s payment terms, preferred delivery method of invoices and preferred payment method. For customers who pay by credit card, you can enter credit card numbers and expiration dates.

NOTES
Transactions from the Customers & Jobs List

Right-clicking on any customer or job in the Customers & Jobs list will bring up a menu which includes access points for launching various customer-related transactions and features, such as:

- Create Invoices
- Create Credit Memos / Refunds
- Create Estimates
- Create Statements
- Enter Sales Receipts
- Enter Statement Charges
- Create Sales Orders
- Receive Payments
- Make Deposits
Work with the Employee Center

Step-by-Step: Add a New Employee

1. Just like the Customer Center, there are multiple ways to access the Employee Center in QuickBooks:
   - Click Employees from the left-hand or top icon bar (depending on your View settings)
   - Choose Employee Center from the Employees drop-down in the menu bar
   - From the Home page, click the blue Employees tab in the Employees section

2. Click New Employee at the top of the Employee Center.

3. Complete all employee information.

4. Click OK.

5. Close the Employee Center by clicking on the x in the top right corner of the Center (not the top right corner of QuickBooks, which will close the program!) or by hitting the Esc key.

   IMPORTANT: Payroll requires additional setup to be ready for processing inside of QuickBooks.
Work with the Vendor Center

The Vendor Center’s Vendor list is where you record information about the companies or people from whom you buy goods or services.

ADD VENDORS

To pay your bills with QuickBooks, you need to add your vendors (sometimes referred to as suppliers). Nearly everyone you pay, other than employees, is a vendor. Your vendor list supplies the names available on purchase forms like purchase orders, bills, checks, vendor credits, sales tax payments, payroll tax payments and bills.

Step-by-Step: Add a Vendor

1. Just like the Customer Center and Employee Center, there are multiple ways to access the Vendor Center in QuickBooks.
   - Click on Vendors from the left side or top icon bar (depending on your View settings)
   - Choose Vendor Center from the Vendors drop-down in the menu bar
   - From the Home page, click the Vendors tab in the Vendors section

2. Click the New Vendor button then choose New Vendor.

3. In the Vendor Name field, enter the name of the vendor as you’d like it to appear on your Vendor list.

4. The Opening Balance field is treated the same as the Customer Center entries. You can enter a balance owed to the vendor as of the start date of the file, but it is best practice to enter individual open bills whenever possible.

5. Enter the remaining vendor information appropriately.
6. Click **OK** to add this vendor.

   The new vendor appears on the Vendor list. (New vendors appear automatically in their correct alphabetical order in the Vendor list.)

7. Close the Vendor Center by clicking on the **x** in the top right corner of the Center (not the top right corner of QuickBooks, which will close the program!) or by hitting the **Esc** key.

**IMPORTANT:** Notice there are additional tabs in the vendor setup window. Feel free to utilize these features as they apply to your business. Pay special attention to the Tax Settings tab if you would like to run 1099 reports from QuickBooks.
Transactions from the Vendor List

Right-clicking on any vendor in the Vendor list will bring up a menu which includes access points for launching various vendor-related transactions and features, such as:

- Write Checks
- Enter Bills
- Pay Bills
- Enter Credit Card Charges
- Create Purchase Orders
Add Custom Fields

QuickBooks lets you add even more information to names on lists by having custom fields in the Customers & Jobs, Vendor, Employee and Item lists. Custom fields allow you to track additional information specific to your business.

**Step-by-Step: Add Custom Fields**

1. Open the Customer Center (or the Vendor Center or the Employee Center).
2. Click on a customer (or vendor or employee, depending on the center you’ve opened).
3. Click the Edit (pencil) button (alternately, right-click on the customer name and choose the Edit option for this type of list name).
4. Click the Additional Info tab.
5. In the bottom right corner of this window, click Define Fields. This opens the Set Up Custom Fields for Names window, which corresponds to your Customer, Vendor and Employee lists.
6. Use the Label column to name your custom field.

7. Place a checkmark in the column for each name list to which you would like the custom field to apply. QuickBooks Pro and Premier allow up to seven custom fields for each of the Customer, Vendor and Employee lists, but with no more than an aggregate limit of 15 custom fields on all lists together.

8. Click **OK**.

9. If you see an informational message, click **OK**.

10. Click **OK** to close the Edit Customer (or Edit Vendor or Edit Employee) window.

11. Close the Customer (or Vendor or Employee) Center.

**NOTES**
Step-by-Step: Add Custom Fields for Items

1. From the Lists menu, choose Item List.

2. In the Item List, select the item you wish to edit.

3. Right-click on the item and choose Edit Item, or click the Item menu button then choose Edit Item.

4. Click Custom Fields.

5. Click Define Fields.

6. Enter the custom field name you would like to use in the Label column.

7. Place a checkmark in the Use column for the field to show in the item setup. QuickBooks Pro and Premier allow up to five custom fields for items.
8. Click **OK** to close the window.

9. If you see an additional Information window about activating custom fields for this list, click **OK** to close this window as well.

10. In the Custom Fields for this (or any) item window, you can now enter information for your new custom field.

![Custom Fields for Lk Doorknobs](image)

11. Click **OK** to close the Custom Fields window for that item, and then click **OK** to close the Edit Item window.

12. Close the Item List.

**NOTES**
Manage Lists

Sometimes you may want to re-order the way your accounts appear in the different sections of your financial reports. You can re-order each section of your Chart of Accounts (within its account type) by following the instructions below.

**Step-by-Step: Sort a List Manually**

1. From the Lists menu, choose *Chart of Accounts*. Scroll to the account you would like to move.
2. Hover the mouse pointer over the **diamond** to the left of the account name.
3. Click and hold the left mouse button, and then drag the pointer upward until you see a dotted line directly above the account name (or downward until you see a dotted line directly below the account name). The mouse button can also be dragged to the right to make it a subaccount of the account above it (assuming it is the same account type), or it can be dragged to the left to move it out of being a subaccount.

<table>
<thead>
<tr>
<th>NAME</th>
<th>TYPE</th>
<th>BAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>31400 - Shareholder Distributions</td>
<td>Equity</td>
<td></td>
</tr>
<tr>
<td>32000 - Retained Earnings</td>
<td>Equity</td>
<td></td>
</tr>
<tr>
<td>40100 - Construction Income</td>
<td>Income</td>
<td></td>
</tr>
<tr>
<td>40110 - Design Income</td>
<td>Income</td>
<td></td>
</tr>
<tr>
<td>40120 - Equipment Rental Income</td>
<td>Income</td>
<td></td>
</tr>
<tr>
<td>40150 - Subcontracted Labor Income</td>
<td>Income</td>
<td></td>
</tr>
<tr>
<td>40130 - Labor Income</td>
<td>Income</td>
<td></td>
</tr>
<tr>
<td>40140 - Materials Income</td>
<td>Income</td>
<td></td>
</tr>
<tr>
<td>40199 - Less Discounts given</td>
<td>Income</td>
<td></td>
</tr>
<tr>
<td>40500 - Reimbursement Income</td>
<td>Income</td>
<td></td>
</tr>
<tr>
<td>40510 - Mileage Income</td>
<td>Income</td>
<td></td>
</tr>
<tr>
<td>40520 - Permit Reimbursement Income</td>
<td>Income</td>
<td></td>
</tr>
<tr>
<td>40530 - Reimbursed Freight &amp; Delivery</td>
<td>Income</td>
<td></td>
</tr>
<tr>
<td>50100 - Cost of Goods Sold</td>
<td>Cost of Goods Sold</td>
<td></td>
</tr>
<tr>
<td>54000 - Job Expenses</td>
<td>Cost of Goods Sold</td>
<td></td>
</tr>
</tbody>
</table>
4. Release the left mouse button to drop the account into the new position.

<table>
<thead>
<tr>
<th>Account Type</th>
<th>Subaccount</th>
</tr>
</thead>
<tbody>
<tr>
<td>40100 · Construction Income</td>
<td>Income</td>
</tr>
<tr>
<td>40110 · Design Income</td>
<td>Income</td>
</tr>
<tr>
<td>40120 · Equipment Rental Income</td>
<td>Income</td>
</tr>
<tr>
<td>40130 · Labor Income</td>
<td>Income</td>
</tr>
<tr>
<td>40150 · Subcontracted Labor Income</td>
<td>Income</td>
</tr>
<tr>
<td>40140 · Materials Income</td>
<td>Income</td>
</tr>
<tr>
<td>40199 · Less Discounts given</td>
<td>Income</td>
</tr>
</tbody>
</table>

5. To re-sort the list (within each account type), click the **Account** menu button in the bottom left corner of the Chart of Accounts screen and select **Re-sort List**.

6. Click **OK**.

7. Close the Chart of Accounts.

You can sort lists in QuickBooks by clicking on column headers in the lists like the Name and Balance Total. The example below uses the Customer Center, but this also applies in the Vendor Center, Item list and Chart of Accounts.
Step-by-Step: Sort a List in Descending Order

1. Open the Customer Center (using any of the access methods described above) and Customers & Jobs list.

2. Click the expand arrow to the right of the View drop-down list to expand the width of the Customers & Jobs list.
The full list view of the Customers & Jobs list displays.

3. Click the **Balance Tot** column heading. This sorts the list in **ascending** order by balance total.

4. Click the column heading again. This sorts the list in **descending** order by balance total.

5. To return to the original order, click the large **diamond** that will now appear to the left of the Name column heading. (Alternately, right-click anywhere in the list and choose **Re-sort List**, then click **OK**.)
6. Click the **collapse arrow** to the right of the window to collapse the Customers & Jobs list.

7. Close the Customer Center.

**NOTES**
In most lists, you can combine two names into one. This is called merging. For example, you may find that you’ve been using two customer names (because of different spellings) when you really need only one on your Customers & Jobs list. You can merge list names in the Chart of Accounts, Item, Customers & Jobs, Vendor, Employee and Other Names lists. This example uses the Vendor list, but the concept is the same regardless of list type. (Accounts on the Chart of Accounts that you wish to merge must have the same account type and should not have subaccounts.)

**Step-by-Step: Merge Items on a List**

1. Open the Vendor Center.

2. Double-click the entry you wish to merge (this entry will be merged into the other entry and any informational fields associated with this list entry will be lost, so make sure you have all the informational fields you need in the surviving entry).

3. In the Vendor Name field, change the name to match the name of another vendor record with which you wish to merge. This should be an exact match in terms of spelling, spacing and punctuation.

4. Click **OK**.
5. You will get a warning dialogue telling you there is another record with this name and asking if you would like to merge. (Remember, you can never un-merge so be very sure this is what you want to do. Also, the Audit Trail report will not report on renamed or merged names, so be sure that this is what you want to do, and for good measure, make sure you have a backup of the file before you do the merge.) Click Yes.

6. Close the Vendor Center.

**IMPORTANT:** You cannot merge two names from different lists such as a Vendor and Customer record or Other Names list record. All transactions containing the original list name will now appear as if they were entered using the renamed, merged list name.

**RENAME A LIST ITEM**

You can rename any list name. When you make the change, QuickBooks automatically modifies all existing transactions containing the list name. (This is very similar to the concept of merging, but without renaming to be exactly the same as another name on the same list.) This example demonstrates renaming in the Chart of Accounts.

**Step-by-Step: Rename a List Item in the Chart of Accounts**

1. From the Lists menu, choose Chart of Accounts to display the Chart of Accounts for Rock Castle Construction.

2. In the Chart of Accounts, select the account you would like to rename.

3. Right-click on the account and choose Edit Account, or click the Account menu button and choose Edit Account.

4. Make your changes in the Account Name field.

5. Click Save & Close.

6. Close the Chart of Accounts.
You can delete list items if you have not used them in any transactions, preferences or customized report filters. If you try to delete a list item that has been used, QuickBooks displays a warning that the item can’t be deleted. If you don’t want to use a list item but you can’t delete it, you can make it inactive. Here is an example from the Customer Center.

**Step-by-Step: Make a List Item Inactive**

1. Navigate to the **Customer Center**.
2. Select the customer or job from the list that you wish to make inactive.
3. Right-click the name and choose **Make Customer:Job Inactive**.
4. To see inactive list items, choose **All Customers** from the View drop-down list.

5. Close the Customer Center.

**NOTES**
Print a List

You can print a QuickBooks list for reference, or you may print a list to a file to use in your word processor or spreadsheet program. QuickBooks prints the Customers & Jobs list as it appears on the screen. For example, if the Customers & Jobs list is expanded and sorted by balance total, QuickBooks prints the expanded list sorted by balance total. If the list is collapsed, QuickBooks prints just the customer name, the balance total and active status.

Step-by-Step: Print the Customers & Jobs List

1. In the Customer Center, click the Print menu button then choose Customer & Job List.
2. Click OK to bypass the List Reports message.
3. Confirm your choice of printer and click Print.

Step-by-Step: Print Information on One Customer

1. In the Customers & Jobs list, select the customer whose details you want to print.
2. Click the Print menu button then choose Customer & Job Information.
3. Confirm your choice of printer and click Print.

If you want to print information for selected customers only, you can generate and filter the Customer Contact List report for those customers. You can also modify the report to include any extra columns you want.
Step-by-Step: Print Information for Selected Customers

1. From the Reports menu, choose List then choose Customer Contact List from the submenu.
2. Click Customize Report.
3. Click the Filters tab.
4. Select Customer in the Filter list.
5. In the Customer field, choose Multiple customers/jobs.
6. Place a checkmark next to those customers whose contact information you want to print.
7. Click OK to close the Select Customer.Job window.
8. Click OK to close the Modify Report window and display the customized report on the screen.
9. Print the report.
11. Close the Customer Center.

NOTES
Add or Edit Multiple Items at One Time

If you have existing list information in Microsoft Excel® that you want to add to QuickBooks, or if you want to make changes to multiple items, you can do so for items in the following lists: Customers, Vendors, Service Items and Non-inventory Parts. (Multiple items may also be added to or edited in the list of Inventory Parts, if the inventory preference is turned on.)

Step-by-Step: Edit or Add Multiple List Names at Once

1. Go to the Lists menu and choose Add/Edit Multiple List Entries.
2. Choose the list you would like to edit from the List drop-down.
3. Use the Customize Columns button to customize the information you would like to see. (This means not only adding and taking away columns, but also changing their order.)

4. Use the Find field if needed.
5. Utilize copying tools by right-clicking in a cell on the grid.
6. To add any new list names, scroll to the bottom of the list and start entering or pasting information into the first empty row. Alternately, you can change the View drop-down choice to display unsaved list names (in the example above, that would be unsaved customers), and you will be able to enter or paste information into an empty grid using the column headers as your guide.

7. When your changes are complete, click **Save Changes**.

8. Click **Close**.

**NOTES**
Work with the Lead Center

The Lead Center tracks data about your sales prospects (who are not yet customers) in one place inside QuickBooks. The Lead Center has three panes:

- Use the **Leads** pane on the left to view and sort your leads
- Use the **Lead Information** pane on the right to review or edit information about a selected lead
- Use the **Tabs** at the bottom of the window to access lists and notes for individual leads

To access the Lead Center, click **Company** on the menu bar and select **Lead Center**. QuickBooks displays the Lead Center as shown:
Step-by-Step: Add a New Lead

1. Choose **Company ➔ Lead Center**.
2. Click the **New Lead** icon.
3. Enter the lead name in the Lead field.
4. Set the lead status. Click the **Status** drop-down arrow and select **Hot/Warm/Cold**.
5. Use the Company and Contact tabs to enter information about the prospect.
6. Enter additional information as desired.
7. Click **OK**.
THINGS TO NOTE ABOUT THE LEAD CENTER

- Each lead must have a unique name. If you’ve already used the name, change it slightly by adding a character or number.

- The Contacts tab provides the ability to enter details about contacts at the company. You can have multiple contacts as needed.

- You can enter one or more locations in the Locations field. If you have multiple locations, you can click the Main Address drop-down arrow and select from the locations you’ve entered.

- You can import multiple leads to enter multiple prospects into the Lead Center at the same time by using the Import Multiple Leads button at the top of the Lead Center then copying and pasting from an Excel spreadsheet.

**Step-by-Step: Convert a Lead to a Customer**

You can convert a lead into a customer when needed. This will move the prospect from the Lead Center to the Customers & Jobs List. Converting a lead to a customer cannot be undone.

**IMPORTANT:** You cannot enter a transaction for a lead; it must first be converted to a customer.

**NOTES**
Work with Lists – Review Questions

1. How many custom fields can you set up for items?
   a. 4
   b. 5
   c. 7
   d. 20

2. Which of the following forms and windows could potentially be populated with information from the Vendor list?
   a. Purchase Orders
   b. Bills
   c. Write Checks
   d. All of the above

3. Which of the following activities cannot be accessed from the Customers & Jobs list in the Customer Center?
   a. Create statements
   b. Assess finance charges
   c. Enter credit card charges
   d. Receive payments

4. On which tab of the Edit Customer window would you enter a customer’s payment terms (for example, net 30 days)?
   a. Address Info
   b. Additional Info
   c. Payment Settings
   d. Job Info
5. A customer has three warehouses and you are installing an overhead door at each location. The best way to track this in QuickBooks would be to:
   a. Set up each location as a separate customer
   b. Set up a separate job for each location under the customer
   c. Enter all work as one order under the customer
   d. Use a custom field to track each location

6. Products you sell would appear on which of the following lists?
   a. Vendor list
   b. Employee list
   c. Chart of Accounts
   d. Item list

7. A subcontractor would appear on which of the following lists?
   a. Vendor list
   b. Employee list
   c. Customers & Jobs list
   d. Item list

8. Name three of the lists on which you can merge names.
   a. ________________________________
   b. ________________________________
   c. ________________________________

9. True or false: You can delete list items that are used in transactions.
   a. True
   b. False
Review Activities

1. Add the following customer using the data below:
   - **Customer Name**: Alla Rozenvasser
   - **Opening Balance**: $234.00
   - **Company Name**: Rozenvasser Advertising
   - **Contact**: Alla Rozenvasser
   - **Bill to**: 300 Main Street, Suite #3, Middlefield, CA 94432
   - **Phone**: 415-555-6767
   - **Fax**: 415-555-9090
   - **Alt. Contact**: Shannon Stubo
   - **Type**: Commercial
   - **Credit Limit**: $2500
   - **Terms**: Net 15
   - **Tax Item**: San Domingo

2. Add a new vendor using the data below:
   - **Vendor**: Martin Drywall
   - **Contact**: Sean D. Martin
   - **Address**: P.O. Box 76, Middlefield, CA 94432
   - **Phone**: 555-5432
   - **Fax**: 555-6565
   - **Account**: 082-4343
   - **Type**: Subcontractors
   - **Terms**: Net 30
   - **Credit Limit**: 1,000.00
3. In the Customers & Jobs list select **Ecker Designs.** Answer the following questions:
   - What is the job status for Ecker Designs’ office repairs?
   - What is the number of the most recent invoice and how much was it?
   - What happened on December 15?

4. In the Vendor Center locate **sales tax payment** transactions. Answer the following questions:
   - Who is the vendor?
   - How many payments have been made?
   - What is the total amount of payments that have been made?

5. In the Employee Center find **Gregg Schneider’s** information. Answer the following questions:
   - What is the name of his spouse?
   - When was Gregg hired?
   - What is Gregg’s overtime pay rate?

6. In the Vendor Center find **C.U. Electric**. Answer the following questions:
   - What is the open balance for this vendor?
   - How many bills are outstanding and what are the amounts?
   - What are the payment terms for this vendor?

7. Open the **Item** list and answer the following questions:
   - How many brass hinges are on hand?
   - What is the price of a patio door?
   - What is the finance charge percentage on overdue balances?
Answers to Review Questions

1. How many custom fields can you set up for items?
   a. 4
   b. ✓ 5
   c. 7
   d. 20

2. Which of the following forms and windows could potentially be populated with information from the Vendor list?
   a. Purchase Orders
   b. Bills
   c. Write Checks
   d. ✓ All of the above

3. Which of the following activities cannot be accessed from the Customers & Jobs list in the Customer Center?
   a. Create statements
   b. Assess finance charges
   c. ✓ Enter credit card charges
   d. Receive payments

4. On which tab of the Edit Customer window would you enter a customer’s payment terms (for example, net 30 days)?
   e. Address Info
   f. Additional Info
   g. ✓ Payment Settings
   h. Job Info
5. A customer has three warehouses and you are installing an overhead door at each location. The best way to track this in QuickBooks would be to:
   a. Set up each location as a separate customer
   b. ✓ *Set up a separate job for each location under the customer*
   c. Enter all work as one order under the customer
   d. Use a custom field to track each location

6. Products you sell would appear on which of the following lists?
   a. Vendor list
   b. Employee list
   c. Chart of Accounts
   d. ✓ *Item list*

7. A subcontractor would appear on which of the following lists?
   a. ✓ *Vendor list*
   b. Employee list
   c. Customers & Jobs list
   d. Item list

8. Name three of the lists on which you can merge names. (Any 3 of these will do.)
   a. ✓ *Chart of Accounts*
   b. ✓ *Item*
   c. ✓ *Customer & Jobs*
   d. ✓ *Vendor*
   e. ✓ *Employee*
   f. ✓ *Other Names*

9. True or false: You can delete list items that are used in transactions.
   a. True
   b. ✓ *False*